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Release Notes

Fiery X3e Color Server, version 1.01

                                  
This document contains information about Fiery X3e Color Server™ version 1.01. Before 
using the Fiery X3e Color Server, make a copy of these Release Notes and distribute them to 
all users.

NOTE: This document uses the term “Fiery X3e” to refer to the Fiery X3e Color Server.

Before printing to the Fiery X3e:

• Make sure that system software version 1.01 is installed on the Fiery X3e.

• Install user software version 1.01 onto client computers. For instructions, see 
Getting Started.

Shutting down the printer

To shut down the printer properly, use the instructions in the Job Management Guide. If 
you do not shut down the printer properly, severe system problems may result, including 
the loss of saved jobs and current default settings.

Error messages

If several printer problems happen at the same time, the control panel will only display the 
last error message.

Readme file

After installing the AdobePS driver, read the README.WRI file (for Windows operating 
systems) or the Adobe PS Read Me (for Mac OS) located on the User Software CD in the 
same directory as the other printer files. This file contains information about potential 
conflicts between the Adobe driver and other software applications. 

Default paper size in Windows 2000 and Mac OS (European English)

The default paper size in the Windows 2000 and Mac OS printer drivers is “Letter.” 
Change it to “A4” before printing.

Paper size label in Windows NT/2000 printer driver

The paper size Tabloid in the Windows NT 4.0 printer driver may appear as “11x17” in 
the Windows 2000 printer driver.

Windows NT 4.0 Installation

Disregard registry errors if they occur when installing the Windows NT 4.0 driver as a 
power user.

Printer options in Windows 2000 printer driver

The options on the Installable Options tab do not accurately reflect the options installed on 
the printer. If the options are properly installed, their functionality is not affected. 

Paper size label in Windows NT printer driver (Italian systems)

The default paper size in the Windows NT 4.0 printer driver is “Tabloid” instead of “A4.”

Printer

Printer drivers
Part number: 450247242001   Electronics For Imaging, Inc.
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Automatic PPD selection (Italian systems)

When you set up the Direct, Print, or Hold queue on Mac OS for the first time, and you 
click the Create button, the correct PPD is not automatically found. Instead, the “Select a 
PostScript Printer Description” window prompts you to locate the Fiery X3e PPD. 

Printing from Adobe PageMaker (French systems)

To print from PageMaker on French systems, copy the file EF3M6A10.PPD from Dossier 
Système: Extensions: Descriptions d’imprimantes to Dossier Système: Extensions: Fichiers 
de description.

Editing device settings

To change print defaults in a driver that was downloaded from the Fiery X3e using WINS 
printing (SMB), the permissions for the Print queue on the Fiery X3e server must be set to 
Full Control for the user Everyone. Once you are logged in with Administrator privileges, 
you can allow a user or all users to change print defaults in the driver by enabling Full 
Control in the Properties/Security/Permission tab. 

Help Message Display

When you click the help button question mark on the upper right corner of the Windows 
95/98/Me or Windows NT driver, and select any field, the help message does not appear.

Renaming the server

If you rename the server, the name must be 10 characters or fewer. 

Fiery Setup

To run Setup from the Control Panel, you must log in with Administrator privileges.

Fiery Server Setup

If a connection to the Fiery X3e fails after changing settings in the General or Printer Setup 
tab of the Fiery Server Setup dialog box, the WorkGroup name and the Domain name may 
be the same. To resolve this problem, use different names.

Remote Setup for Bindery and NDS

When configuring Bindery or NDS in Network Setup using Fiery WebSetup or Command 
WorkStation from a client computer, enter a password in order to make changes. For 
Bindery Setup, log in as Admin, Supervisor, or Guest with the appropriate password. For 
NDS, select the appropriate login and password.

Security Settings in Internet Explorer

When accessing Fiery WebSetup from Internet Explorer, an unexpected warning message 
appears if security is set at the default level. To prevent this, modify the Internet Explorer 
security settings as follows:

1. From the Tools menu, select Internet Options.

2. Click the Security tab.

3. With Internet zone selected, click Custom.

The Security Settings window appears.

Setup
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4. Scroll down to Java. Under Java Permissions, select Custom, and then click Java Custom 
Settings.

5. Click the Edit Permissions tab.

6. Under Unsigned Content:Run Unsigned Content, select Run in Sandbox.

This security option runs WebSetup while keeping your system secure.

7. Under Additional Unsigned Permissions:Access to all Network Addresses, select Enable.

This setting enables communication via SNMP.

8. Click OK, and then click OK again.

9. In the Internet Options window, click Apply. 

Your new settings take effect after you restart your browser.

Out of Range Setting

When performing Server Setup from Fiery Web Setup, your browser will close suddenly 
when a value beyond the possible range is input for Date and Time.

Port 9100 Setting

Enable Port 9100 is not functional when performing Network Service Setup from Fiery 
Web Setup. Port 9100 can be enabled from the Fiery X3e control panel.

IPX Auto Frame Type

If you select Yes to enable IPX Auto Frame Type in Setup, the Fiery X3e will bind only to 
the first frame type it finds, which is typically 802.2. To ensure that all available frame types 
are bound, select each one individually. After the Fiery reboots upon exiting Setup, print 
the Configuration page to verify that all selected frame types were successfully bound.

TCP/IP and DHCP Servers

In some cases, Mac OS computers may crash when attempting to obtain an IP address from 
a DHCP server while loading the TCP/IP driver. Check the TCP/IP Control Panel to make 
sure that you have a valid IP address and that the router and DNS server addresses are valid 
before running applications such as ColorWise Pro Tools.

Auto IP Configuration (RARP)

When using Enable Auto IP Configuration to obtain the IP address over the RARP 
protocol, the IP address does not print correctly on the Configuration page.

Windows Setup (WINS Printing) from the Fiery X3e Control Panel

Depending on your selections for setting a domain for WINS printing, the Fiery X3e 
prompts you that it will reboot. Choose OK when prompted. This allows the Fiery X3e to 
retrieve a current list of domains. Allow the Fiery X3e to reboot and return to Setup to 
finish making the settings.

Parallel port printing

When printing continuously several jobs through the parallel port connection, the jobs may 
be RIPped as one job.
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Cover Page (PS Setup)

When you print a job with a Cover Page to multiple bins, the Cover Page is printed to the 
last bin.

Courier Substitution

When Allow Courier Substitution is set to Off, PostScript errors will not be generated.

E-mail Setup

To set up E-mail Services, use the Fiery X3e Control Panel, not Fiery WebSetup.

Restore Backup

Fiery X3e system software resides on the hard disk drive and is backed up the first time you 
power on the Fiery X3e. If necessary, you can retrieve a backup of the system software using 
the Restore Backup command. Press the first line selection button on the Control Panel 
during diagnostics to display the Restore Backup menu, and select Restore Backup. 
Selecting Restore Backup restores the system software to the factory default configuration.

Fiery X3e passwords 

The Fiery X3e password used to access Setup, as well as the password required to log in to 
the Fiery X3e, are case-sensitive and must be entered exactly.

Maximum number of connections to the Fiery X3e

The maximum number of connections that can be made to the Fiery X3e at any one time is 
eight. This includes any kind of connection (whether utilities or network) from any kind of 
client workstation (any Windows platform or Mac OS).

AppleTalk on Windows 2000

When using AppleTalk on Windows 2000 computers, print to the Hold or Print queues.

UNIX printing

There may be incompatibility problems with some UNIX environments.

Command WorkStation connection lost

If the message “Connection to the Fiery X3e lost.” is displayed in the Command 
WorkStation window, click OK and then reboot the Fiery X3e using Reboot System from 
the Functions menu on the Control Panel. You can then launch Command WorkStation to 
re-establish the connection.

Rebooting from Command WorkStation

If you reboot the server from Command WorkStation, the Fiery X3e control panel displays 
an extra message, “Alert Sleep,” for 10 seconds.

Installing software

Software for Command WorkStation and Fiery utilities can be installed on the Fiery X3e. 
Do not install any other applications on the Fiery X3e. Other applications are not 
supported and can cause system problems.

System

Installing software 
on the Fiery X3e
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Disk full error message

When the hard disk drive on the Fiery X3e is full, any print jobs sent to the Fiery X3e will 
not print until the current job is finished. You can remove completed jobs from the printed 
queue to free up more disk space.

Windows NT 4.0

If you make settings in Properties>Device Settings tab>Installable Options for the 
Windows NT 4.0 printer driver, these settings are not reflected on the Configuration tab.

Some paper sizes are listed twice, but with different names. For example, Tabloid and 
“11x17” are both listed, but refer to the same paper size.

Watermarks are not supported.

The Print Page Borders function is not supported.

With some combinations of Layout (for example, 2-up, 6-up, etc.) and Stapling, the staple 
position is incorrect.

Paper size label in Windows NT/2000 printer driver

The paper size Tabloid in the Windows NT 4.0 printer driver may appear as “11x17” in the 
Windows 2000 printer driver.

Printing to the Direct connection

If you wish to print to the Direct connection, enable at least one additional Fiery X3e print 
queue (Print or Hold) in Fiery Printer Setup.

Rotated Landscape in Windows 2000

Jobs will not print with the specified orientation when you select Rotated Landscape in the 
Windows 2000 printer driver.

Copies

Although you enter the maximum for the number of copies (for example, 9999), the 
Fiery X3e prints only three copies and the printer returns to Ready. Command 
WorkStation, however, reports 9999 copies were printed.

Duplex jobs with mixed paper sizes

If you print a duplex job with mixed paper sizes, the job may not be printed at all. If any of 
the job is printed, the job is printed on only one side of the paper, and the orientation of 
the job is incorrect.

Duplex jobs with 2-up or 6-up layout

When you print a duplex job with a 2-up or 6-up layout in Windows NT 4.0, the Top-Top 
and Top-Bottom settings give the opposite result from what you intended. For example, 
Top-Top gives output that is actually Top-Bottom, and vice versa. To avoid this problem, 
choose the setting that is opposite of what you intend.

Tray selection in Windows 2000

When you select a specific paper tray to print from with the Windows 2000 printer driver, 
the Fiery X3e prints from any tray that has the correct size paper, not necessarily the tray 
you have specified.

Printing
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Load Paper Size message

If a paper tray has only one piece of paper and you print a one-page job, the message “Load 
Paper Size” appears. The job, however, is printed correctly, and the message disappears after 
printing is complete.

Font substitution

In the printer drivers for Windows 9x, font substitution is not supported.

Paper size

When sending a job from an application (such as Microsoft Word) that allows you to 
specify paper size in the Print dialog box, be sure to select the same paper size in both the 
application’s Page Setup dialog box and the printer’s Properties dialog box.

When using European drivers, the Page Size print option default may appear as Letter. If so, 
click Defaults to display the correct A4 default size.

Paper Source

The Paper Source option displays both “Automatically Select” and “Auto Select.” To allow 
the printer to select the paper source automatically, use “Auto Select.”

Postcard media type

To print on postcard media, use the selection “Thick Paper 2.”

Printing on 4x6 or A6 paper size

When you set 4x6 or A6 paper size to the Tray 1 setting on the Fiery X3e control panel, the 
rotation switch for selecting the media type of tray 1 should not be set to Thick1.

Scale setting

The scale settings for a job that has been scaled using the printer driver are not reflected in 
the job’s Properties dialog box. 

If you print a job on Legal (11x14), 11x17, A3, or 12.25x18 size paper with a scaling factor 
of more than 350%, the job may be printed as a blank page instead of the expected output.

Negative 

For the Negative printer driver option to function, turn off the Black Overprint and Pure 
Black Text and Graphics options.

The Negative, Mirror, and Unprintable Area printer driver options are not supported on 
Windows NT 4.0.

CMYK Simulation Profile

Depending on the image you print, there may be a gap in color gradations, sometimes 
known as banding.

Stapling

To get stapled output, you must first choose a Sorter Mode. 

If you print in Portrait orientation with either an N-up or Duplex setting and also specify a 
Staple setting, the job may not be stapled correctly. To avoid this problem, print the job in 
Landscape orientation. You may be unable to staple your print job using the Single Stapler 
Finisher.
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If you select stapling for a job that exceeds the finisher’s 50-page stapling limit, the job may 
print, but stapling is not guaranteed. Either the first 50 pages will be stapled or no pages 
will be stapled.

Cover Page 

Selecting the Cover Page option in the Mac OS printer driver may produce unexpected 
results and may prevent the Duplex options from functioning correctly. If a cover page is 
required on Mac OS systems, use the Fiery X3e cover page, which the Administrator 
specifies in PS Setup on the Fiery X3e Control Panel. 

Page Range

You cannot access the Page Range option from the printer driver. Use the application page 
range option, or change the setting for this option from Command WorkStation, Fiery 
Spooler, or Fiery WebSpooler.

FreeForm Printing

If you create a master page with the page size set to Letter-R (short edge feed direction) and 
print with Use Master Page and staple and punch on, the master page and variable data may 
print in opposite directions.

Printing the Euro currency symbol—Windows 2000

The Fiery X3e supports the following PostScript fonts for printing the Euro currency 
symbol: Courier, Times Roman, Helvetica, and Arial.

PDF files

If you download a PDF file and specify more than one copy and that the output be sorted, 
the output is not sorted. To get sorted output, open the file in Adobe Acrobat and print the 
job with one of the printer drivers provided on the User Software CD.

PostScript Patches

Occasionally a .ps patch that has been downloaded will not appear in the Job Log. When it 
does appear in the Job Log, it will display a different name for the patch. To check that the 
patch has been applied, print the Configuration Page after rebooting the Fiery X3e.

Printing the Comparison page

You cannot calibrate the Fiery X3e for media other than plain paper. 

Connecting to the Fiery X3e

You can connect to only one Fiery X3e at a time.

Override settings

If the Notes 1 field is empty when you send the job to the Fiery X3e, you can add 
information to this field in Fiery Spooler.

Job processing time

The job processing time displayed from WebSpooler is different from the actual time to 
process the job.

Printer fonts

Fiery Downloader

ColorWise Pro 
Tools

Fiery Spooler

Fiery WebSpooler
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Override settings

If you override job settings from Fiery WebSpooler, verify all settings before you reprint the 
job. Some settings may be changed from their original settings.

Connecting with Mac OS computers 

If MRJ (Microsoft Runtime for Java) version 2.2.4 is installed on your Mac OS computer, 
Fiery WebSpooler may not connect to the Fiery X3e. Even if Fiery WebSpooler does 
connect, attempting to export the Job Log will cause the system to stop responding.

Mac Runtime for Java (MRJ) 2.2.4

If you have MRJ 2.2.4 installed on Mac OS, you may not be able to connect to 
WebSpooler. You must edit your Internet Explorer browser preferences for Mac OS to 
connect to WebSpooler properly. Use the following instructions to edit your browser 
preferences:

1. Open Internet Explorer.

2. Select Preferences from the Edit menu.

3. Scroll to Web Browser and click Java.

4. Verify that Restrict Access to Non-Java Class Files is not checked.

5. Clear the Internet Explorer cache by selecting Advanced under Web Browser and selecting 
Empty Now.

6. Restart the browser.

Thumbnails in Fiery WebSpooler

Working with Thumbnails in Fiery WebSpooler on Netscape Communicator v4.7 may 
produce the following unexpected behavior:

• Thumbnail tabs may be blacked out.

• An image cannot be moved from Thumbnail B to Thumbnail A.

• If your document has many pages, not all pages may display. The scroll bar can not be 
moved to show all pages.

• The Save and Save As commands may not work properly.

Override settings

Selecting Command WorkStation override settings may cause a print job to process 
incorrectly. If you override a specific setting for an option from Command WorkStation 
and then open the job settings again to replace that setting with Printer’s Default, you may 
get unexpected printing results. To avoid this, do not choose Printer’s Default when you 
override print settings from Command WorkStation, or remove the original raster file 
before you override print settings again.

If you edit (add or delete) pages in the Thumbnail view in WebSpooler or Command 
WorkStation and save them, and then override the job settings from WebSpooler or 
Command WorkStation, the original number of pages that were in the job before editing 
will be printed.

Command 
WorkStation
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Cancel Printing

If you choose Cancel Printing from the Server menu and restart the Fiery X3e before the 
cancel function has been completed, you will lose the connection to the Fiery X3e, and 
unknown errors may be displayed. 

PageMaker job properties 

In PageMaker, the job property for paper source may be displayed as inputslot instead of 
tray.

Downloading PDF files

Downloading PDF files to the Direct connection is not supported. Instead, use either the 
Print queue or the Hold queue.

When you download a large PDF file, the RIP bar shows the amount of the file processed as 
“0 KB.” Despite this, the file RIPs and prints correctly. 

Status

Status information displayed in Fiery Link may require extra time to update. Therefore, the 
status displayed in Fiery Link may not match the status displayed in Command 
WorkStation.

Tray status

The list of trays that appears in Fiery Link is not automatically updated when a new tray is 
installed on the printer. To view an updated list of trays installed on the printer, restart 
Fiery Link. 

Edit My Fiery List

When you have the Edit My Fiery List window open and you click the Advanced button or 
the Refresh button, the Edit My Fiery List window may hide new dialog boxes. To prevent 
this, move the Edit My Fiery List window off to one side before you click either the 
Advanced button or the Refresh button.

Closing Fiery Link on Mac OS

On Mac OS computers, Fiery Link does not appear to close when you select Quit from the 
File menu. Fiery Link still appears as open in the status bar at the top of the screen, 
although the utility is closed. You may have to quit the utility several times to get it to show 
as closed.

All

If a collate option or a scaling option is available and selected within the application or 
printer driver, unexpected results may occur. Make sure collation or scaling is not selected 
within the application, and then select the feature within the Fiery X3e printer driver.

In particular, if you send a job to the Fiery X3e to be stapled, the job is not stapled if you 
have selected the Collate option in the application. 

When you print a black-and-white job duplex, set the Color Mode to Grayscale in the 
Fiery X3e print options. This gives proper reporting of the number of black-and-white 
pages on the Job Log.

Fiery Link

Applications
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When selecting a paper size in some applications, you have two choices for “Autoselect.” In 
this case, use the second “Autoselect.” 

Not all applications support the options Negative, Mirror, and Orientation. 

Microsoft Office

Microsoft Word 97—In Microsoft Word 97 on Windows 95/98, when printing jobs of 
more than 1000 pages in reverse order, the first 1000 pages are RIPped and printed before 
the remaining pages are RIPped and printed. 

In Microsoft Word 97 on Windows NT 4.0, when printing jobs with Pure Black Text and 
Graphics print settings set to Off, the job is printed with black only text. 

Microsoft Excel

Printing Workbooks—If you choose Entire Workbook in the Print dialog box from 
Microsoft Excel for Windows, the job may print as separate jobs. This is because Excel 
sends each worksheet to the printer as a separate job. Print settings such as Duplex and 
Sorter Mode will be applied to the first worksheet and ignored for the rest. To apply print 
settings, you need to select each sheet, go to Page Setup/Options, and select the print 
option settings for your job. To print the entire workbook, select all sheets in the workbook. 
Click on the first worksheet tab at the bottom of the Excel page, hold down the Shift key, 
and click on the last worksheet tab. Select Print from the File menu. In the Print area of the 
Print dialog box, select Active Sheets, and the job will print correctly.

Multiple copies—If you select a number larger than one for the Number of Copies option 
in Microsoft Excel 97 and the Collate box is also checked, Excel will send multiple, 
identical jobs to the Fiery X3e. You must uncheck the Collate box before you send multiple 
copies from Excel.

QuarkXPress

Windows version—The N-Up, Watermark, Mirror Image, and Negative Image options do 
not function in QuarkXPress for Windows.

Adobe PageMaker

Printer’s Default—Do not choose Printer’s Default when printing from PageMaker. 
PageMaker does not recognize the Printer’s Default information in the Fiery X3e PPD. 
Selecting Printer’s Default in PageMaker may cause unexpected printing results. 

Euro currency symbol—The Euro currency symbol does not print correctly from 
PageMaker when using an Adobe PostScript printer driver. The symbol will print correctly 
from PageMaker when another printer driver is used.

Corel Draw

In Windows NT, the PPD feature for the number of copies may display corrupted 
characters.

Internet Explorer 5.5

To collate your multiple page print job from Internet Explorer 5.5, you must select the 
collate checkbox within the application and then select the feature within the Fiery X3e 
printer driver.
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